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From The Chief Editor's Desk
So many of our PCLinuxOS family members live literally with a few hours of each other, but so few of us have ever met in person. The only PCLinuxOS users that I have ever met are those that I convinced to give PCLinuxOS a try. And I already knew them, personally. I already considered them friends. Outside of my immediate family that lives in my own home, that number is quite low. I try to not be that annoying, evangelistic PCLinuxOS "preacher." But, if I see a situation where PCLinuxOS can help, I'm quick to make the suggestion that they at least give the Live media a try.
The PCLinuxOS family is unique in its friendliness and helpfulness. Over time, many of us make "friends" with other PCLinuxOS users from all around the globe. I know I consider many PCLinuxOS users friends from all corners of the globe: England, Ireland, Germany, China, Thailand, South Africa, Canada, Mexico, Brazil, France, Greece, Poland, Netherlands, and of course, the U.S. I'm sure there are other countries harboring PCLinuxOS users that I missed, but that list is just off of the top of my head.

Life happens, and people come and go. That's just normal. But others stay and stay, and those bonds strengthen over the years. And yet, despite those bonds, they never meet, face-to-face. Often times, it's logistically impractical to ever meet. They may live on another continent, separated by a vast ocean. At other times, it may be political divisions that prevent "friends" from ever meeting.
But when you live only hours away, it's exceptionally sad to never meet those with whom you share a special bond face-to-face. Years and years have been invested in developing those bonds of friendship, yet a few measly hours prevent ever meeting up face-to-face.
The recent and unexpected death of our beloved PCLinuxOS family member Sproggy has brought this thought front and center in my mind. Sproggy and I shared that special friendship bond. However, logistically, I think we both knew how improbable it was that we'd ever be able to meet up. The vast Atlantic Ocean separated us, with him living in the U.K., and me in the U.S. Still, we made plans for the day when we would finally be able to meet up. But the distance never deterred us from wishing, hoping, and making those plans. Now, with his passing, those plans will forever remain just unfulfilled wishes and hopes. With all of the time we spent talking and working together, I feel as if I *know* his wife and kids. I know many of the trials, tribulations and troubles he faced. I even knew he was 5' 10" (178 cm) tall, and weighed around 220 pounds (99.8 Kg). He also "knew" my wife and kids, as well as many of the trials, tribulations and troubles I've stared down.
There is a point where someone who is "just another user" becomes more than that. They become friends. They become part of your extended family. They enhance your very being. The sum is greater than the individual parts. Over the years, you both develop that special bond with one another.
There are many around the PCLinuxOS family, past and present, that I'd love to meet up with. I'd love to share tacos and a beer with Tex. I'd love to accompany ms_meme on one of her daily strolls. I'd love to meet up with Meemaw for a nice lunch over some awesome Kansas City BBQ. I'd like to hang out with Crow, so he could show me those beautiful sights in Mexico and some local, authentic Mexican food.
seems like he'd be a blast to hang out with and throw back a pint. I'd love to visit with Rudge and JRex, and swap recipes. Mr Cranky Pants-YouCanToo would be great to do the same thing with. Joechimp would be fun to visit with or hang out with, no matter the situation. I wonder if Old-Polack's speech is as colorful as his posts. In fact, there are a lot of you that I would love to meet up with, so my apologies if I didn't list you. You're probably on the list, but I don't have room here to list all of you.
So, if there's that PCLinuxOS family member that you've developed that special bond and friendship with, by all means, make every attempt to meet them. If you live in a big city, look for other PCLinuxOS users in your area. Meet them for a cup of coffee at a coffee shop, or even at a fast food restaurant. You could even make it a monthly or weekly event. But, if only a few hours separate you, there really is no excuse to meet at least once. There are things that simply cannot be conveyed online.
Until next month, I bid you peace, happiness, serenity and prosperity.
R.I.P, Sproggy! You Will Be Missed!
by Paul Arnote (parnote)
On December 23, 2019, our beloved PCLinuxOS family member, Sproggy, lost his battle with cancer.
The news was delivered by his oldest son, Kyle. The post read:
I didn't know where to put this. My name is Kyle, and my dad was forum member Sproggy or Kori.
I know he has been a long time user of your software, and he always loved being part of your community. It is with sad news that I am informing you that my dad passed away on 23rd December 2019.
He had been battling cancer for a couple of years. It started in his bowel and ended in his lungs.
Even to the end, he was still very jokey, and wanted me to let you know he always felt at home with you all here.
He left me with instructions that if anyone would like the master copies of his artwork that I can share them with them. Please message and I can send them zipped separately in email.
His PC is going to stay with me, so I will have access to his work.
Thanks,
Kyle
(Follow the previous link to view reaction to the sad news from the PCLinuxOS family.)

Kori Tilcock, a.k.a. Sproggy, a.k.a. Kori Tk
Born on March 7, 1974, Sproggy was only 45 years old when the cancer brought his life to a way-too-early end. He leaves behind his wife of 27 years, Mo, his daughter Neecey, and his two sons, Kyle and Connor. They resided in Bedford, England (the last I knew). His most recent job was as a senior applications engineer for Mastercard, maintaining their databases on the backend of the system.
Remembering Sproggy
When I first joined the PCLinuxOS forum, Sproggy was a moderator. We both hit it off pretty early on. My interactions with him increased a lot when I took over the editor's role for the magazine. We would chat frequently -- usually daily -- in the magazine's IRC channel on FreeNode, then called #pclinuxos.mag (it's now #pclosmag).
We would chat about everything and anything. We'd talk about family, politics (particularly anytime there was a General Election coming up in the U.K.), world events, personal trials and tribulations, work, what's for dinner, and sometimes just nonsense. There was hardly a topic we didn't touch on. At that time, the magazine's IRC channel was a hopping place. Joble, Hootiegibbon, CSolis, grnich, ms_meme, AndrezjL, Meemaw, myself and many others frequently hung out there. Sproggy would join in on the conversations with just about everyone.

Sproggy and his wife, Mo
I have fond memories of the "argument" we had on whether milk gravy would/should be considered gravy. He always said no. I would goad him on, telling him he hadn't lived until he had a big platter of biscuits smothered in sausage gravy (and I knew JUST the place to take him, if I ever got the chance). We often talked about the possibility of meeting up, face to face, should he get the chance to visit the U.S. someday. He and Mo actually did get to make the trip to the U.S. once, but they became ill while here, and we weren't ever able to make the meeting happen. We always talked about throwing back a pint, if and when that happened. Most recently, in early November, he and I made "plans" to head to the shooting range to shoot skeet when he and Mo finally made it over here on another trip.
When I wasn't available for chats, Sproggy would spend a lot of time talking with Meemaw.
Meemaw recalled her conversations with Sproggy with fondness. "I always loved it when Sproggy came into IRC. We discussed a lot of things, but mainly talked about our families or artwork. When he made one of the versions of his Xfce called Phoenix, he actually let me design one of the logo wallpapers that he included. He was always very kind and supportive of my graphics efforts, even though his were so much better. I was chatting with him in November shortly after he started posting his new wallpapers, and shared a couple with me before he posted them. He mentioned that if he couldn't sleep or was in pain, he would go to the computer and do some graphics. I learned so much from him, and will miss him terribly," she said.
Sproggy was a passionate person, and he directed that passion into things that mattered to him. His interests included Linux (particularly PCLinuxOS), the Xfce desktop, and his graphics/artwork. He was or became highly skilled in them all. He created the first iteration of Xfce on PCLinuxOS that I ever tried, and it was his Xfce remaster that made me an avid Xfce fan.

When I first took over the editor's role on the magazine, gseaman (Galen) was doing the monthly layouts for the magazine's HTML edition. When Galen decided to step back from the magazine to refocus on packaging, Sproggy stepped in to do the job. He continued to do the magazine's layout of the HTML version for the next couple of years, before handing that job over to Rudge.
When a new version of Xfce was forthcoming, Sproggy learned packaging so that he could compile and package up the new version of Xfce. He became quite good at it, too.
Sproggy left his PCLinuxOS family for a while, starting in 2012ish. While he checked in periodically over the ensuing years (he made it a point to tell me that he was a fan of Ika's Xfce community remaster), he returned to his PCLinuxOS family full time in July, 2019, and remained with us up until the end.
He shared his new PCLinuxOS-oriented artwork with his PCLinuxOS family. Working on his artwork was therapeutic for Sproggy, as he'd sometimes wake up in the middle of the night. He wouldn't be able to sleep due to the pain, so he'd sit at his computer and put his creative talents to use.

Through it all, Sproggy never gave us much indication of just how serious his condition was. While I'd like to think that maybe even he didn't know, I know that isn't true. He knew. That's why he came back to the one place that felt like home to him: his PCLinuxOS family.
Perhaps the most telling sign he gave us came in a poignant post he recently made to the forum. The post was a month and a half before his untimely demise. It read (emphasis mine):
Well, I got asked recently why I have returned to PCLinuxOS after so long away ... the last few years I have been very unwell progressively getting worse ...
Being part of PCLinusOS community brought me so much joy when I was an active member ... it made me feel like I belonged somewhere for once ... but these last few years I have felt I needed to give something back and share some love with the group for that time.
I have just finished another round of chemo & radio ... I have had 3 tumours removed from my bowel and the tumour in my lung has been shrunken, but it is still there ... I have corrosive esophagitis, duodenitis, blood clots and nodules littering my lungs, sinus tachycardia, several auto-immune deficiencies caused by the chemo.
I don't know how long life has left so I am here to create art as that's what I enjoy most and share that with you guys ... I hope to see whatever time is left bringing some smiles to people's faces before I am checked out.
Hopefully, this will clear up the curiosity ... peace & love people.
Kori

Without a doubt, PCLinuxOS has lost a valued family member when cancer took Sproggy from us, way ahead of his time. He had a lot more living to do, and a lot more to accomplish. Who knows, in the absence of the cancer, what all he may have gone on to do.
We'll miss you Sproggy! We'll miss your humor, your wit, your insights and all of your contributions yet to come that will remain unfulfilled. We'll miss your fun-loving spirit. Thank you for all that you contributed in the time that you were among us.
All of us here at The PCLinuxOS Magazine extend our most heartfelt condolences to Sproggy's family. He touched many lives here, so we can only imagine the loss you must be feeling.
ms_meme's Nook: PCLinuxOS Is All There Is
PCLinuxOS Recipe Corner: Impossibly Easy Bacon Pie
Impossibly Easy Bacon Pie

INGREDIENTS:
12 slices bacon, crisply cooked, crumbled
1 cup shredded Swiss cheese (4 oz)
1/3 cup chopped onion
3/4 cup Original Bisquick™ *See our Homemade Bisquick Recipe
1 1/2 cups milk
3 eggs
1/8 teaspoon pepper
DIRECTIONS:
Heat oven to 400 degrees F. Grease 9-inch glass pie plate. Sprinkle bacon, cheese and onion into pie plate.
In medium bowl, beat remaining ingredients until blended; pour into pie plate.
Bake 35 to 40 minutes or until knife inserted in center comes out clean. Let stand 5 minutes before serving.
TIP:
Chop 3 green onions to use, instead of the chopped yellow onion.
Impossibly Easy Bacon Pie can be covered and refrigerated up to 24 hours before baking. You may need to bake a bit longer than the recipe directs since you'll be starting with a cold pie. Watch carefully for doneness.
* See our Homemade Bisquick Recipe at http://recipes.dm-enterprises.net/?p=recipe&recipe=289
De-Googling Yourself, Part 8
by Alessandro Ebersol (Agent Smith)

We have reached the end of this series, and let's reflect on all of that's been discussed before.
Don't Be Evil... No more
We saw that Google's motto is no longer, they have changed, now it is Do the right thing, and that can be many things depending on where you look.
But as we want to preserve ourselves from the "eyes" of the big brother, we will have to take some precautions.
Google's Do's and Don'ts
Well, as we've seen before, I'm not going to go over already-trodden terrain, but to list, in a succinct and straightforward way, what to do to lessen Google's intrusion into our private lives.
Google's DNS
Google's famous DNS, 8.8.8.8, should not be used.
Google may "hide" sites it doesn't want to promote. Use OpenDNS instead (208.67.222.222)
Use Only HTTPS (Hyper Text Transfer Protocol Secure)
HTTPS (HTTPS) is an implementation of the HTTP protocol over an additional layer of security that uses the SSL/TLS protocol. This additional layer allows data to be transmitted over an encrypted connection and to verify server and client authenticity through digital certificates. The TCP port used by default for the HTTPS protocol is 443.
The HTTPS protocol is used, as a rule, when it is desired to prevent the information transmitted between the client and the server from being viewed by third parties, such as online shopping. The existence in the address bar of a lock (which can be left or right depending on the browser used) demonstrates secure page certification (SSL/TLS). The existence of this certificate indicates the use of the HTTPS protocol and that communication between the browser and the server will take place securely. To verify the identity of the server, double-click the lock to view the certificate.
Over HTTPS connections, third-party MITM attacks are not possible because the connection is encrypted end-to-end. Thus, it is possible to track that you have accessed a particular site, but not what you have accessed on that site.
Watch out for cookies!

A cookie is a simple string of text loaded into users' browsers when they visit a site. Its goal is to enable the site to recognize and remember its users. But cookies make up the majority of online website crawlers.
The cookie was invented in 1994 by Netscape's Lou Montulli and John Giannandrea, and originally served to provide websites with a "memory" so that they could, for example, store items in a shopping cart while the user searched for the goods on the site.
Although the cookie still serves this purpose, it can also monitor users and provide a lot of information about user behavior.
The cookie is widely used for profiling and targeted marketing, and most websites set a large number of both their own and third party cookies.
There are also many different cookies: required cookies, analytics or statistics cookies, marketing cookies, and advertising cookies. Strictly necessary cookies work so that a site operates its most basic functions, so that a visitor can visit it. These rarely, or never have any way of tracking users.
However, analytics or statistics cookies are usually third-party cookies that track and record user behavior to provide information to the site owner. Marketing and advertising cookies are also often third party cookies that serve to make targeted advertising possible. These cookies are site tracking tools for the companies involved: The company itself, the site owner, and companies that use cookies for tracking and profiling (Google and all others in the ad technology industry: Yahoo, Bing, Facebook , etc ...)
Types of Cookies
As we saw above, there are "normal" cookies, but there are still two other types of cookies: Supercookies and Evercookies.
Supercookies contain a unique identifier that allows trackers to link records in their data to track their history and browsing behavior (for example, websites visited including length of stay). An example is Flash cookies (also known as Local Sharing Objects or LSO) which, unlike standard cookies, work independently of the browser and have no expiration date. They are stored locally and can be removed manually. To prevent them from being stored on your device, you must set the Flash plugin in your browser to not load flash objects or only with your consent. To do this, select the "Never Activate" or "Prompt to Activate" options.
Evercookies are extremely persistent and difficult to get rid of when they get into the device. Its purpose is to identify a user even after removing standard cookies, Flash and others. Evercookies use different storage mechanisms to store data in different formats at various locations on your device. If cookie data is removed, it is immediately recovered from an alternate storage location.
Countermeasures
To protect yourself from spy cookies, there are some precautions you can take.
However, over time, user tracking techniques have evolved to become more elaborate and complex.
Tracking users without cookies
Tracking pixels, also called 1x1 pixel or pixel tags, are transparent images that consist of a single pixel, present (though virtually invisible) on a web page or in an email.
When a user loads the webpage or opens an email, the tracking pixel is also loaded, allowing the sender of the tracking pixel, usually an ad server, to read and record that the webpage is loaded or the email is open and similar user activities.
The purpose is the same as for third party cookies: to get user information for targeted marketing(or whatever purposes)
Information that may be obtained by websites and third parties through tracking pixels includes:
Location Tracking pixels are a widely used form of analytical or statistical tracking, but the General Data Protection Regulation (GDPR) considers it illegal if it is not first consented to by the user.
Tracking with Javascript
Tracking scripts are parts of Javascript code that usually implement a tracking pixel on a site and are responsible for creating different request types for external domains, passing the data to them.
The tracking script can access and create requests using the data available on the page, as well as set different cookies that can be used as identifiers. This commonly transmitted data consists of data available in HTML, a URL, a data layer, cookies, or obtained through an event listener or an API call. The tracking script can make different types of requests to pass this information to the tracking pixel.
An example of tracking javascript is "analytics.js" from Google.
Countermeasures
To avoid problems with trackers without cookies, either transparent gifs or scripts, the following extensions can be installed:
The NoScript extension provides extra protection for Firefox, Seamonkey, and other browsers (Google Chrome): This free, open source add-on allows JavaScript, Java, Flash, and other plugins to be run only by trusted websites of your choice (eg. your bank's website).
NoScript also provides the most powerful anti-XSS and anti-Clickjacking protection ever available in a browser.
NoScript's unique whitelisting-based preventive script blocking approach avoids exploiting security vulnerabilities (known as Meltdown or Specter and even not yet known!) without loss of functionality.
You can enable JavaScript, Java, and plug-in execution for trusted sites by simply left-clicking on the NoScript status bar icon or by using the contextual menu for easy operation in pop-up windows without a status bar.
Adblock Plus is an ad filtering extension for Firefox, Chrome, Opera, Microsoft Edge, Internet Explorer, Yandex and Maxthon.
This program was included in the list of Firefox add-ons as of January 17, 2006. Due to its huge usage, around 80,000 downloads per day have been reported, reaching 100 million in total.
Like Mozilla's image blocker, Adblock blocks HTTP requests according to their source addresses and can block IFrames, scripts and Flash. It also uses automatically generated user stylesheets (CSS) to hide, block, elements such as text-based applications on a page as they load.
A smart extension that controls javascript, iframes, and plugins in Google Chrome.
Scriptblock is an extension that provides better control of javascript, iframes and other unwanted content.
It can even mitigate cross site scripting (XXS) and drive-by-downloads attacks.
ScriptBlock works perfectly in conjunction with other extensions like AdBlock, AdBlock Plus or Ghostery.
You can add trusted sites to a whitelist so that they are not affected by ScriptBlock.
Available for Palemoon and Google Chrome.
Fingerprinting
Fingerprinting is an advanced browser identification technique that the user is accessing in order to uniquely and accurately identify the user.
There are several Fingerprinting techniques, and let's illustrate some of them. In fact, the sophistication of Fingerprinting is such that it seems to come out of a spy movie.
Basically, there are 4 types of Fingerprinting:
Canvas Fingerprinting
HTML Canvas allows the web application to draw real-time graphics, with functions to support drawing shapes, arcs, and text in one Custom canvas element. Differences in font rendering, anti-aliasing, and other device features make devices draw the image differently. This allows the resulting pixels to be used as part of the device fingerprint. The image below is a representative example of the types of screenshots used by fingerprinting scripts.

AudioContext Fingerprinting
Fingerprinting techniques are not usually used in isolation, but together. One of the new fingerprinting techniques accesses the AudioContext interface and related interfaces. Trackers try to use the audio API to fingerprint users in various ways.
How it works? An audio signal is generated by an oscillator and the resulting signal is split after processing to create an identifier. This does not require access to the device microphone and depends on differences in the way the generated signal is processed.
In the figure below, the fingerprint audio of my notebook (where I wrote this article) compared to the fingerprint audio of a standard Android reference device.

Also, with this technique, it was possible for the script to profile my hardware admirably:
AudioContext Fingerprints
AudioContext properties:
{
"ac-sampleRate": 48000,
"ac-state": "suspended",
"ac-maxChannelCount": 0,
"ac-numberOfInputs": 1,
"ac-numberOfOutputs": 0,
"ac-channelCount": 2,
"ac-channelCountMode": "explicit",
"ac-channelInterpretation": "speakers",
"an-fftSize": 2048,
"an-frequencyBinCount": 1024,
"an-minDecibels": -100,
"an-maxDecibels": -30,
"an-smoothingTimeConstant": 0.8,
"an-numberOfInputs": 1,
"an-numberOfOutputs": 1,
"an-channelCount": 1,
"an-channelCountMode": "max",
"an-channelInterpretation": "speakers"
}
Fingerprint using DynamicsCompressor:
35.73833402246237
Fingerprint using DynamicsCompressor (hash of full buffer) :
5f5ca60e8aa59e3b0f1f5d3064746a42b760ed57
Fingerprint using OscillatorNode:
Fingerprint using hybrid of OscillatorNode / DynamicsCompressor method:

WebRTC Local IP Discovery
WebRTC is a framework for real-time, point-to-point communication in the browser and accessible via Javascript. To find the best path between peers, each pair collects all available candidate addresses, including addresses from local network interfaces (such as Ethernet or WiFi) and public-side addresses from NAT, and makes them available to the Web application without explicit permission. of user. A fingerprinter script can leverage these addresses to track users.
Canvas-Font Fingerprinting
Javascript and Flash were used to enumerate fonts in the browser and also to profile users.
The HTML Canvas API provides a third method for deducing fonts installed in a specific browser. The screen rendering interface exposes a measureText method, which provides the resulting width of the text drawn on the screen. A script can try to draw text using a large number of fonts and then measure the resulting width. If the text width is not equal to the text width using a default font (which would indicate that the browser does not have the tested font), the script may conclude that the browser has that font available.
As an example, here is the data that a test script extracted from my notebook:
Canvas, Javascript, and Flash Font Detection
Canvas font detection:
Andale Mono; Arial; Arial Black; Bitstream Vera Sans Mono; Calibri; Cambria; Cambria Math; Comic Sans Courier; Courier New; Georgia; Helvetica; Impact; Lucida Console; Lucida Sans Unicode; Microsoft Sans Serif; Palatine; Segoe UI; Tahoma; Times; Times New Roman; Trebuchet MS; Verdana; Wingdings;
JS / CSS font detection:
Andale Mono; Arial; Arial Black; Bitstream Vera Sans Mono; Calibri; Cambria; Cambria Math; Comic Sans MS; Courier; New Courier; Georgia; Helvetica; Impact; Lucida Console; Lucida Sans Unicode; Microsoft Sans Serif; Palatine; Segoe UI; Tahoma; Times; Times New Roman; Trebuchet MS; Verdana; Wingdings;
Flash font detection:
AD MONO, Adventure, Andale Mono, Arial, Arial Black, Babelfish, Bitstream Charter, Bitstream Vera Sans, Bitstream Vera Sans Mono, Bitstream Vera Serif, Blue Highway, Condensed Blue Highway, Calibri, Cambria, Cambria Math, Cantarell , Cantarell Extra Bold, Cantarell Light, Cantarell Thin, Christmas School, Comic Sans MS, Courier New, DejaVu Math TeX Gyre, DejaVu Sans Condensed, DejaVu Sans Light, DejaVu Sans Mono, DejaVu Serif, DejaVu Serif Condensed, Deutsch Gothic, Dingbats, DirtyBaker'sDozen, Georgia, Hershey-Gothic-English, Hershey-Gothic-German, Hershey-Plain-Duplex, Hershey-Plain-Duplex-Italic, Hershey-Plain-Triplex, Hershey-Plain-Triplex-Italic, Hershey-Script-Complex, Hershey-Script-Simplex, Impact, Larabiefont, Liberation Mono, Liberation Serif, Lucida Console, Lucida Sans Unicode, Microsoft Sans Serif, New, Nimbus Mono L Nimbus Roman No9 L, Nimbus Sans L, Nimbus Sans L Condensed, Segoe UI Light, Segoe UI Light, Standard Symbols L, Symbol, Tahoma, Times New Roman, Trebuchet MS, URW Bookman L, URW Chancery L, URW Gothic L, URW Palladio L, Utopia, Verdana, Webdings, Wingdings
Countermeasures
To try to "fool" fingerprinting, you can install some extensions in your browsers:
Secret Agent (Palemoon, Waterfox, Seamonkey, Icecat) enhances the privacy of your web browsing by rotating the identity of the browser 'User Agent' with all web requests ( or each page load or session of each browser).
Randomizing your User Agent makes it a little harder for bad guys, rogue ISPs, spies like Phorm, corrupt governments, and other nasty surveillance / tracking threats to correlate your clicks based on device fingerprinting.
Ghostery is a free, open source privacy and security related browser extension, plus a mobile browser application. Since February 2017, it belongs to the German company Cliqz International GmbH (formerly owned by Evidon, Inc., formerly Ghostery, Inc. and the Better Advertising Project). The code was originally developed by David Cancel and associates.
Ghostery allows its users to easily detect and control JavaScript tags and trackers. JavaScript bugs and beacons are embedded in many web pages, largely invisible to the user, allowing the collection of user browsing habits through HTTP cookies, as well as participating in more sophisticated forms of tracking, such as canvas fingerprinting.
As of 2017, Ghostery is available for Mozilla Firefox, Google Chrome, Internet Explorer, Microsoft Edge, Opera, Safari, iOS, Android, and Firefox for Android (not available for Palemoon, Seamonkey, Icecat).
Use And Abuse Private Browsing
A Private browsing automatically deletes browsing information such as passwords, cookies and history, leaving no trace after you log out.
Private browsing is available on all popular browsers (Firefox, Chrome and all derivatives thereof)
TOR and VPN
Using TOR browser can get you in trouble:
The U.S. Supreme Court quietly approved a rule change that would allow a federal magistrate judge to issue a search and seizure warrant for any target using anonymity software like Tor to browse the internet.
As for Virtual Private Network (VPN) networks, they're as good as the companies behind them. That is, as long as these companies don't hand over your browsing history and data to government agencies, you're fine.
But otherwise...
I think that both the TOR browser and virtual private networks deserve their own articles, where they can be further analyzed.
Final Words
Over the course of eight months, we thoroughly and thoroughly analyzed the ways Google uses to spy on its users.
We've looked at the known ways, and many new online tracking technologies, that in these perilous times we live in, where freedom of thought and expression can put the average citizen in hot waters, given the prevailing polarization and political radicalization.
Protecting privacy, freedom of thought and expression has become a necessity these days, but mostly staying out of trouble, controversy and online discussion that can hurt ordinary people (as Richard Stallman was harmed by giving his opinion on a very sensitive subject).
So take a good look at tips for protecting your online privacy, and especially don't get involved in controversy or sensitive issues, whether it's on Twitter, Facebook, YouTube or whatever, as out-of-context statements can cost careers, reputations and even jobs.
A big hug, and see you next month.





Short Topix: Mozilla Removes Avast, AVG Firefox Extensions Over Snooping Claims
by Paul Arnote (parnote)
Google Now Bans Some Linux Web Browsers

In its "infinite" wisdom, Google has now blocked certain Linux web browsers from accessing its services, according to an article on BleepingComputer. These Linux web browsers include Falkon, Konqueror and QuteBrowser. All but QuteBrowser are in the PCLinuxOS repository. Google asserts that they "may not be secure" ... as if logging into any Google service is like logging into some kind of fortress of security and privacy.
The issue was reported on Reddit by u/onedoer. Ironically, there are also several replies in the Reddit thread of other users who have had no problem using the aforementioned Linux web browsers.
BleepingComputers, in their independent tests, were able to confirm -- on multiple machines -- the inability to log into Google services on both Falkon and Konqueror. Clicking on the "Learn More" link reveals a number of reasons that Google provides for the possible block. They could include lack of support for JavaScript or having JavaScript support turned off, having unsecure or unsupported extensions installed, the use of automated testing frameworks, or the browser is embedded in a different application.
There is only speculation about why the web browsers work for some users, but not others. Google has not yet responded to a query from BleepingComputers with an answer of any kind. Imagine that.
Mozilla Removes All Avast, AVG Firefox Extensions Over Snooping Claims

Do you remember the free antivirus package AVG Free by Avast from back in your Windows days? Or, maybe you are aware of their current "antivirus" offerings for Linux. Well, for the past couple of years, Avast has made available four addons for Firefox. They are Avast Online Security, AVG Online Security, Avast SafePrice, and AVG SafePrice.
In late October, Wladimir Palant, the creator or AdBlock Plus discovered that these addons were collecting WAY, WAY, WAY more information than was necessary to perform their duties. Take a look at the information collected, as pointed out from Palant's blog:
The interesting fields were:
uri: The full address of the page you are on.
title: Page title if available.
referrer: Address of the page that you got here from, if any.
windowNum and tabNum: Identifier of the window and tab that the page loaded into.
Initiating_user_action windowEvent: How exactly you got to the page, e.g. by entering the address directly, using a bookmark or clicking a link.
visited: Whether you visited this page before.
locale: Your country code, which seems to be guessed from the browser locale. This will be "US" for US English.
userid: A unique user identifier generated by the extension.
plugin_guid: Seems to be another unique user identifier.
browserType and browserVersion: Type (e.g. Chrome or Firefox) and version number of your browser.
os and osVersion: Your operating system and exact version number (the latter only known to the extension if Avast Antivirus is installed).
All of this information, and more, was transmitted to Avast and AVG servers. According to a gHacks article, data was sent whenever a user opened a page or switched tabs, as well as every single click on a search page.
If the above revelation didn't unnerve you, take a look at this assertion on Palant's blog page:
The data collected here goes far beyond merely exposing the sites that you visit and your search history. Tracking tab and window identifiers as well as your actions allows Avast to create a nearly precise reconstruction of your browsing behavior: how many tabs you have open, what websites do you visit and when, how much time do you spend reading/watching the contents, what do you click there and when do you switch to another tab. All that is connected to a number of attributes allowing Avast to recognize you reliably, even a unique user identifier.
Palant reported the excessive data collection to Mozilla, and received a polite "thank you" for his notification. Then, in less than 24 hours, Mozilla quietly removed the Avast and AVG addons from the Mozilla addon repository, stopping short of putting them on the blacklist (which would have inactivated/removed every installed copy on users' machines).
In response, Avast provided the following statement:
We have offered our Avast Online Security and SafePrice browser extensions for many years through the Mozilla store. Mozilla has recently updated its store policy and we are liaising with them in order to make the necessary adjustments to our extensions to align with new requirements. The Avast Online Security extension is a security tool that protects users online, including from infected websites and phishing attacks. It is necessary for this service to collect the URL history to deliver its expected functionality. Avast does this without collecting or storing a user's identification.
We have already implemented some of Mozilla's new requirements and will release further updated versions that are fully compliant and transparent per the new requirements. These will be available as usual in the Mozilla store in the near future.
Avast claims, via a BleepingComputer article, that it had less than 12 hours to resolve the issue.
As of the writing of this article (late December), the issues appear to have been resolved, and the Avast and AVG addons are once again available in the Mozilla addon repository. Avast provided the following statement to gHacks:
"Privacy is our top priority and the discussion about what is best practice in dealing with data is an ongoing one in the tech industry. We have never compromised on the security or privacy of personal data. We are listening to our users and acknowledge that we need to be more transparent with our users about what data is necessary for our security products to work, and to give them a choice in whether they wish to share their data further and for what purpose. We made changes to our extensions including limiting the use of data and these changes are explained clearly in our Privacy Policy. Our browser extensions Avast Online Security and AVG Online Security are back on the Chrome Store, and on the Mozilla Store (since 12/17). It's important to us that users understand that we're listening to concerns about transparency and data use, and striving to do better and lead by example in this area."
Through at least the beginning of this "event," the Avast and AVG extensions remained available through the Google Play Store. Avast's response seems to indicate that at some point, the extensions were also removed from the Google Play Store.
Firefox Launches Firefox Private Network Browsing

(From the Mozilla blog) In September, we (Mozilla) introduced the beta release of our Firefox Private Network (FPN), an extension which provides a secure, encrypted path to the web to protect your connection and personal information when you use the Firefox browser. Since then, we've received feedback from our beta testers on how they're using FPN, its protections, and we learned about websites that weren't compatible as well as connection issues. This allowed us to quickly identify and fix bugs, and ensure a stable product.
As we continue our beta testing, we are considering various ways to bring additional privacy protections to our users. Today we're announcing an additional beta test for US-based Firefox account users who didn't get a chance to get in the initial group, and are interested in testing FPN.
In the next phase of our beta, we are offering a limited-time free service that lets you encrypt your Firefox connections for up to 12 hours a month. With the holidays around the corner, the FPN couldn't come at a more convenient time. We know people are traveling and might have to rely on an unsecured public Wi-Fi network, like the one at the airport, at your local coffee shop, or even at your doctor's office. FPN provides encrypted internet traffic thus giving you peace of mind whenever you're using our browser.
This limited-time free service is currently available in the US on the Firefox desktop browser and you'll need a Firefox account to try the service. You can sign up directly from the extension which can be found here.
For those looking to extend their protection beyond the browser, you can now sign up to be one of the first to experience the newest member of the FPN family. This month, Firefox account holders can request invitations to experience device-level protection with our new full-device VPN (virtual private network). Join the waitlist and if you're eligible, we'll follow up with a link to access the VPN at an introductory price of $4.99 per month. Currently the VPN will be available for Windows 10 only, and like the rest of the FPN, it is only available to US-based Firefox account holders. Pricing and platform availability will continue to evolve and we look forward to hearing your feedback.
Firefox Says NO To Fingerprinting

One of the topics at this past summer's Google IO developer conference was how to help preserve user privacy by blocking "fingerprinting." Well, Firefox just did an end run around Google, and has blocked fingerprinting. So exactly what is fingerprinting?
Virtually everyone knows what cookies are when it comes to web browsing. Cookies are easy to block, and many sites give you the option to opt out of them. But fingerprinting is different. It collects basic information from your browser session and your computer, using it to create a unique "fingerprint" of you. Included may be the make and model of your computer, how much RAM you have, processor identification, web browser, screen resolution, your timezone, the language you use, the combination of third-party extensions you have installed, and even the fonts installed on your system. From all of that, it's rather easy to create a very specific and unique profile that can be used to track you across the web. Unfortunately, it happens without most users even realizing that it's happening, and there are mostly no mechanisms to allow a user to opt out of fingerprinting.

Starting with Firefox 72, due out later this month, Firefox will block fingerprint trackers by default. But, you don't have to wait until Firefox 72 to block fingerprint trackers. You can enable it now. In Firefox versions as early as 70, you can turn on protection against fingerprint trackers. Go to Preferences, then Privacy & Security. Under the "Enhanced Tracking Protection" section, select either "Strict" or the "Custom" setting. Under the "Custom" setting, you can choose to allow or disallow certain types of trackers. Strict just blocks them all. Even though turning on all the tracker and script blockers is basically the same as just selecting the Strict setting, I prefer to have the option of turning things off and on as I see fit. Also, the custom setting gives me a little more control of how strict I want to get about blocking trackers and scripts.
Make Sure Your Password Isn't Among The 100 Worst Passwords Of 2019

SplashData has released their list of the top 100 worst passwords of 2019. The battle for the absolute worst password wasn't really a battle or competition -- it was the same as the worst password of 2018: 123456. Some variation of the worst password (123456) occupies six of the ten worst passwords in the list. You can view the worst passwords, ranked 50 through 100, here. To view the top 49 worst passwords, go here.
Over and over, users don't seem to be getting the message about using strong passwords to protect their data and privacy. Here at The PCLinuxOS Magazine, we've run numerous articles about passwords, password security, and methods to employ in creating secure passwords.
To summarize, be sure to follow a few simple rules for the creation and use of passwords. First, don't reuse passwords between sites and programs that ask for one. Use ONLY passwords that are unique to each site. Second, don't use birthdays, street addresses, and names of your spouse, children and pets ... basically, anything that is easily associated with you. Third, use a method of generating passwords that is known only to you. This means that you can use a "base" password that is tailored/altered for each site you need a password for, as an example. Fourth, mix uppercase letters, lowercase letters, numbers and punctuation marks in your password creation process. It makes it much more difficult for hackers to break your password.
It's YOUR data. It's YOUR privacy. No one else is going to bother to protect it for you, so that is your responsibility, and yours alone. The temptation to gain access to your privacy and data is too tempting to allow someone else to be responsible for. Don't make the mistake of underestimating the value of your data and privacy.
PCLinuxOS Roundup

AT THE BEGINNING OF 2019, Google announced their Manifest V3 plans, which ultimately broke several ad blocker extensions, and made them a lot less effective. Now, users are raging against Google for their web API called getInstalledRelatedApps. It has been in development since 2015, and has been available to experiment with since Chrome 59 came out in 2017. Basically, the API lets developers determine if their native app is installed on your device. The outrage comes from the potential to violate users' security and privacy, according to an article on Forbes. The potential for abuse is ripe, and given Google's oversight (or lack thereof) of the Google Play Store, users have every expectation that Google's oversight of the use of this API is most likely going to be sorely lacking.
CYBERSECURITY ANALYSTS AT THE NEWLY FORMED SENTINEL LABS claim to have found some of the first hard links between the crimeware organization TrickBot and Lazarus Group, the cyberwarfare division of the North Korean military's Reconnaissance General Bureau, according to an article on TechRepublic.
ACCORDING TO AN ARTICLE ON DECRYPT, hackers have a new way to surreptitiously mine Monero cryptocurrency on your computer. They will drop malware somewhere on your computer, where it remains unknown to the user. The malware itself doesn't contain malicious code, but when activated by a series of commands, it will start using the infected user's computer to mine cryptocurrency. The code lies in an inactive state, remaining undetected, until it is activated by the series of commands. It then sends the mined Monero to a wallet controlled by the hacker.
HOW DO YOU FEEL ABOUT YOUR SMARTPHONE TRACKING YOU everywhere you go, and monitoring everything you do? If you think it isn't a big deal, and you're willing to "live with it" as it currently exists just for the convenience that your smartphone provides, you need to read this introductory opinion article from the New York Times. It's worse than you think, and they provide ample evidence about just how bad the situation really is. This article will likely scare the bejeezus out of you, as it should. This is the inaugural article of a seven article series that is, to say the least, eye opening.


GIMP Tutorial: Photo Filmstrip
by Meemaw
Last month, we saw a Repo Review of the program PhotoFilmStrip, which allows you to create a slideshow from your chosen photos. However, if you want a single image that includes several photos, you can create something like the following in GIMP. I've seen this done by others but we've never covered it in these tutorials, so I thought I'd do one. In this tutorial, we can make a filmstrip out of several photos we load, and use the Curve Bend filter to make it something other than a straight rectangular strip.

I used 5 photos from a recent trip to the mountains. You could use less or more, I'm sure. When you have your photos selected, open GIMP and choose File > Open As Layers. Your photos will open in one GIMP project, and you'll be able to see them in the layers window.

While you are here, you can reorder your photos into the order you want them by moving the layers. When you are satisfied, choose Filters > Combine > Filmstrip. In the window, you can keep the defaults and click OK. I unchecked the boxes dealing with showing the numbers on the filmstrip.

You'll get a new project with the filmstrip. If you want to, you can delete the first project with the photos opened as layers.

To give yourself room to work, add a transparent layer 2000px by 2000px. Then click Image > Fit Canvas To Layers.

Choosing the layer with the photos, and using the Move tool, move the filmstrip to just above and to the right of the center of the canvas.
: The openings in the filmstrip are still white and we want them transparent like the background. First, right click on the layer and choose Add Alpha Channel. Click on the Select by Color tool and then click on one of the white rectangles to select the color white. Now, choose the eraser tool. We're going to start our eraser on one end of the filmstrip and use that tip we learned a few issues ago. Click on the end rectangle, then holding down the Shift key, click on the rectangle at the other end to erase them all. Merge your layers.
We need to stretch out the first photo so it will look right when we bend our filmstrip. With the Rectangle Select tool, select the first photo, then choose the Scale tool, and move the border of your selection to the left so it's just over twice the length that it was, and click Scale.

Make a copy of the filmstrip by clicking <CTRL> + C, then <CTRL> + V. The copy is over the original, of course, but in a floating layer. Flip the copy vertically, then move it beneath the original, and then set the opacity to about 40%.

The copy is now on a floating layer, so you should anchor it.
Using the rectangle select again, select both filmstrips, then click Filters > Distorts > Curve Bend. You'll get the first window below. In the center you'll see the setting "Curve for Border". Click on Upper first, and drag the left end of the line from center to the shape you see in the second window below. Then choose Lower, and drag the center line to the lower shape.


Click on OK. This filter takes a few seconds to work depending on your system. Notice that this is also put on a floating layer, and you can see the original strip below the curved strip.

Right click the floating layer and choose "To new layer". You can now delete the layer with the straight filmstrip.
Let's give this a background. Create a new transparent layer and move it underneath your filmstrip. Choose the Gradient tool, FG to BG, and make your foreground black and your background white. Start at the top of the top strip and drag to the top of the bottom strip.

Let's also make the reflection fade out a bit like it should. Choose the filmstrip layer, right click it and click Add Layer Mask. In the Add Layer Mask window, make sure White is chosen. In the Layers toolbox, click on the layer mask next to the filmstrip and using your gradient again, click from the bottom of the window a little diagonally and up into the strip a bit so the mask fades out the bottom part of the strip. How far you go is up to you.

Now you can merge your layers, and crop your creation, and you're finished!


![]()

Tip Top Tips: Move Firefox 71's Tab Bar BACK To The Bottom
Editor's Note: Tip Top Tips is a semi-monthly column in The PCLinuxOS Magazine. Periodically, we will feature -- and possibly even expand upon -- one tip from the PCLinuxOS forum. The magazine will not accept independent tip submissions specifically intended for inclusion in the Tip Top Tips column. Rather, if you have a tip, share it in the PCLinuxOS forum's "Tips & Tricks" section. Your tip just may be selected for publication in The PCLinuxOS Magazine.
It seems like about every six releases or so, Mozilla's Firefox developers change the format (or change something in the format) for the userChrome.css file that allows users to customize their Firefox interface. Then, Firefox users who have tweaked the Firefox interface to be **just right** for their use have to start all over again and try to figure out the new changes to get their customizations back. The last change to the userChrome.css occurred with Firefox 65.
Right on cue with Firefox 71, Mozilla's Firefox developers have done it again. Yep. They have altered SOMETHING in the userChrome.css file that renders previous userChrome.css file iterations ineffective and rather useless.
So, this month's tip comes from Ramchu, where he shows us how to move Firefox 71's tab bar BACK to the bottom-most spot on the Firefox toolbar, where many users prefer it to be, and where many users feel it should be. Color me (Paul Arnote, the magazine's chief editor) a believer of both. At LEAST give us a choice, amongst all the other choices users are presented with to easily make the desired change.
Ramchu's PCLinuxOS Forum post appears in its entirety below.
I just noticed that in Firefox 71 they have once again moved the TAB BAR to the top, and I prefer that it be below the address/URL bar and the bookmarks bar.

To get the tabs,once again, below the address bar and bookmarks bar, click this link,download and save the file: https://www.userchrome.org/samples/userChrome-tabs_on_bottom_Fx70.css
Rename the saved file to userChrome.css
Open your File Manager, and select the option to "Show Hidden Files."
Navigate to and open the hidden .mozilla folder.
Open the firefox folder.
Open the default folder.
Open the chrome folder. If the folder doesn't already exist, then create it. Be sure to name it chrome.
Rename the current userChrome.css file (if there is one), to something like userChrome.css.old.
Now move the userChrome.css file that you downloaded into the chrome folder.
Close and restart Firefox your tabs should now be on bottom.
I got all of this from:
https://support.mozilla.org/en-US/kb/forum-response-tabs-below-url-bar.
Summary
For the life of me, I don't know WHY Mozilla's Firefox developers will NOT put a simple checkbox amongst all the other various user configurable settings that will remove this perennial thorn from the sides of Firefox users who prefer/want/desire their tab bar to be the bottom-most item on the toolbar. Instead, users who prefer their tab bar on the bottom have to do this periodic ritualistic dance to return their tab bar to its rightful place each and every time the Firefox developers whimsically make changes to the userChrome.css file or format. Geez!
One checkbox. BAM! Done! It would be so freaking easy!
C'mon Mozilla!


PCLinuxOS Family Member Spotlight: rgradle
What is your name/username?
My name is Rich Gradle, (rgradle on the forum).
Are you married, single?
My wife Lori and I have just celebrated our 36th wedding anniversary. She is from the Pittsburgh area, where we met. I always liked Pittsburgh, as the people are very friendly and some parts of the city are very scenic, especially during the winter. Pittsburgh is very hilly, so not a great place to drive around in the winter, but scenic nonetheless.

How about Kids, Grandkids (names and ages)?
We have one son, a daughter-in-law, 2 grand-dogs, 1 grand-cat, and 1 grand-python. No grand-children yet, but those things sometimes take a while.
Are you retired, still working and if working, what do you do?
My wife and I are both retired.
Where do you call home? What is it like? IE: weather, scenery
We currently call Raleigh, NC, our home. We have lived here for about 28 years. We like this area because we are close to the beach, close to the mountains, and close enough to Pittsburgh to drive up for a visit.



Where did you go to school and what is your education level?
I have a Masters Degree in engineering from Texas A&M University. Most of my career was spent in new product development for a company that sells high pressure critical service equipment to power plants. My work resulted in three patents, with two more in the pipeline.
What kind of things you like doing? hobbies, travel, fishing, camping?
Several years ago I bought a banjo so I could learn how to play bluegrass banjo music. After a number of years practicing, and much to my chagrin, I came to the realization that I have very little musical talent. I am still trying to learn, but with somewhat lowered expectations than when I first started.
Why and when did you start using Linux?
I have been using PCLinuxOS for over 10 years now. I normally build my own computers. I had just built a new one and was contemplating loading a new version of Windows, plus trying to decide on which virus and malware software I would need to get. I had been reading about Linux in general, and noted that Linux machines are generally not bothered by the viruses, etc., and are generally considered to be more secure. I decided I had had enough with all the Windows problems, and proceeded to downloaded 3 Linux distros to try out, PCLinuxOS being one of them. Of the three I downloaded, PCLinuxOS was the only one that worked 100% out of the box -- sound worked and wifi worked without having to do a lot of configuration first. Sold!!
What specific equipment do currently use with PCLinuxOS?
PCLinuxOS (KDE) is currently running on my desktop machine (ASUS m/b with AMD A10 processor), and on an HP laptop computer (AMD Phenom II/Mate). Performance on the desktop machine is great, but a bit slow on the laptop. I do some video editing for my church on the desktop machine using Kdenlive, a native Linux application that is very powerful. I also do some graphics development for the church using GIMP. Very powerful, but long learning curve with GIMP. Now I wish I had paid more attention to the GIMP articles that appeared in the PCLinuxOS magazine some time ago. I have a Windows 10 virtual machine on my desktop computer for a few applications that will not run under Linux. My wife, a Windows user from way back, was right at home on her KDE desktop in no time at all. When people try to tell me how complicated Linux is to use, I always bring up my my wife's experience as an example of how easy Linux, and especially PCLinuxOS, is to use.
One of the things I always appreciate about PCLinuxOS is that the software is well thought out, meaning that the updates generally work well and without problem. This is really a nod to those to maintain the software in the repository. Thank you, thank you. Also, I always appreciate the help available on the forum. Even when I have made newbie errors, someone is always willing to provide direction to get me on the path forward. Just outstanding.
Do you feel that your use of Linux influences the reactions you receive from your computer peers or family? If so, how?
My extended family, including my son, mostly use MAC's, and they have no problem taking any opportunity to give me a ration of grief about not using a MAC and an iPhone. Using Linux just adds a little to the amount of grief I get, and a bit of head shaking. But, in the end, I just grin.
What would you like to see happen within PCLinuxOS that would make it a better place. What are your feelings?
While I think that PCLinuxOS is the best Linux distro available today, I am somewhat perplexed that there are so many Linux distros. Seems to me that consolidation down to a very few distros might be helpful in getting applications to port to Linux, and getting hardware vendors to better support Linux.
Finally, thanks to Tex, et. al., for the great job they have been doing with PCLinuxOS.
PCLinuxOS Family Member Spotlight is an exclusive, monthly column by YouCanToo, featuring PCLinuxOS forum member. This column will allow "the rest of us" to get to know our forum family members better, and will give those featured an opportunity to share their PCLinuxOS story with the rest of the world.
If you would like to be featured in PCLinuxOS Family Member Spotlight, please send a private message to youcantoo, parnote or Meemaw in the PCLinuxOS forum expressing your interest.



IPTV: Free Streaming Over The 'Net
by Paul Arnote (parnote)
Today, people are cutting the cable TV cord like never before. There are several reasons.
First, as prices rise, people are finding themselves less able to afford such a "luxury" as cable TV. Budgets tighten, and people's pay doesn't seem to go up nearly as fast as the cost of the bills. Something has to give. I'm firmly of the belief that one of the reasons for the cable TV prices going up and up and up is the increasing number of people cutting the cord. The upkeep costs on the distribution system remains relatively static, and with fewer people paying that monthly bill, those who remain with the cable TV provider have to bear a bigger brunt of those upkeep costs. Of course, the providers don't want to see their profits decrease, so the costs of the monthly service continue to spiral upward.
Second, with all the streaming options today ... Netflix, Amazon, Disney+, Hulu, and an ever-growing list of other entertainment providers ... it doesn't make a lot of sense for many people to be tied to a rigid channel lineup. Most people don't care about much more than a dozen of the hundred-plus channels in a typical cable TV lineup, and people want to watch what they want to watch on their own schedule.
Third, at least in the U.S., if you live near or in a larger city, there are a lot of additional choices of OTA (over the air) channels that were never available before digital TV became the norm.
Well, welcome to another choice, and a possible fourth reason to cut the cable TV cord: IPTV. It stands for Internet Protocol TV, and you can now stream your favorite channels online. It will require some diligence on your part to be sure you can continue to receive your favorite channels, but in the end, it just may be worth it.

It could hardly be much easier to implement, too. Download the m3u playlists off of the internet, and play those playlists in VLC or Kodi. I use VLC, rather than installing Kodi, which I have found becomes a full-time job just to maintain. Voila! Free TV!
So where do you find the IPTV playlists? Well, you could Google them. There are literally hundreds of lists out there from different people compiling them. But, at best, it's a crap shoot. Here's why: the list of servers changes daily. So, what worked yesterday or works today, probably won't work tomorrow. This is where some diligence on your part will pay off. Some lists have hardly any channels that play. Others lists have a much greater percentage of playable channels. So, you will have to find a playlist provider that has a good track record, and you'll have to download a new playlist every day.
Fortunately, I've found one such playlist. It is out of Germany, and their playlists have a high percentage of playable channels. It's at a site called GratisIPTV. The playlists are sorted by country, so you should be able to find the most current playlist for your locale. Since I'm in the U.S., I usually download the U.S. playlists. However, I have downloaded the UK playlists at times, and had good luck viewing them in VLC.

I typically visit the site daily to download the most current playlist, and store it in a directory called "iptv" in my Downloads directory. I usually just right click on the link, and select "Save link as..." from the context menu in my web browser (usually Firefox). Do that for each of the playlists listed, if there are multiple playlist files as in the example above. It literally takes me less than a minute to do this every day.
Once you have the playlists downloaded, launch VLC. I find it easiest to simply drag the playlist I want to play from my file manager (Thunar in my case, since I'm running the Xfce desktop), and drop it into the VLC window. Alternatively, you should also be able to go to the "Media" menu, and select "Open file..." from the menu. Then, just select the playlist you want to explore.

When you first drop the playlist into VLC, you will likely see just the name of the playlist in the right pane. Double click it to open up all of the channel choices, which should then look something like what's depicted in the image above. Now, just double click the channel you want to watch, and you should be well on your way to viewing your choice of programming.
Most of the channels are presented in high definition, and you're likely to be quite amazed at the quality. If you're doing this on a HTPC (home theater PC), it's unlikely that you'll even realize that you're not watching it from cable TV.
Legality
The legality of doing this will vary, depending on the laws of your locale. Thus, I recommend streaming your channels through a VPN ... let's say, to avoid any "legal entanglements."
Possible Enhancements
It should be a relatively easy/trivial task to write a bash script that automatically downloads the playlist(s) using wget or curl. I just haven't done it yet, because I haven't yet had the time to put into it. From what I can tell, the naming scheme used doesn't change much. Only the date of the list really changes. So, the bash script can generate the appropriate filename, and then download the new files. You could also have the script delete any old m3u files in your "iptv" directory. Otherwise, you'll have to manually perform that task. Just imagine that after 30 days you'll have 150 different m3u playlists in your directory, if you download five playlists each day. Also, if you assign the bash script to a cron job, then the new playlists can be downloaded automatically every day in the background. Or, you could just run the bash script every day. Either way, it would greatly lighten the burden of keeping up with the maintenance tasks associated with using IPTV.
Summary
Of course, as with just about anything else, your mileage may vary. At home, and over my VPN, I can connect to channels all day long without any issues. Meemaw, on the other hand, has had sporadic luck, using the exact same playlists that I'm using. One day nothing would play, then the next, a file played right away. It's unclear if her ISP was blocking access, which is a real possibility. I know at the hospital where I work, the hardware-based firewall precludes/forbids connection to a VPN (that I have found so far), so I cannot use my VPN while connected to the hospital's wifi (as much as I would like to). The firewall at the hospital also prevents me from connecting to IRC. Likewise, very few channels play on my computer at the hospital. I guess having a few channels play is better than having none of them play. But the same channels play just fine at home from the same playlist.
If you are experiencing problems connecting with the playlists, I recommend trying it with a VPN. There are free VPN services out there such as ProtonVPN (no data limits, and no logs policy ... the latter is very important!), Windscribe (also no logs policy, with 10 GiB data limit per month), and Hide.me (no logs policy, with a 2 GiB data limit per month). I'm sure you might be able to find others. Be careful, though. Many of the "free" VPN services may limit your monthly data to only 500 MiB, so they really won't do well for streaming. You'll burn through that in no time at all.
I use a paid VPN service (Private Internet Access, a.k.a. PIA), and it only costs me a few dollars a month (paid as a yearly plan). If you want to get an idea of what's available for free VPN services, check out the TechRadar article on the subject. Many of the free services also offer paid VPN service. If you want to go with a paid VPN, check out the article on Tom's Guide that ranks the paid VPN services. ExpressVPN has consistently came out on top in just about every "VPN ranking" article I've seen lately. Even paying for a VPN service is way, way, way cheaper than the monthly cable bill, on the order of something like less than 10% of the cost.
You owe it to yourself to at least try it. You have little to nothing to lose. You may just discover a new way to (at least) find some entertainment value when you're on the go.


PCLinuxOS Bonus Recipe Corner:
Ground Beef Stew over Garlic Mashed Potatoes
Ground Beef Stew over Garlic Mashed Potatoes

INGREDIENTS:
1/2 lb lean (at least 80%) ground beef
1/4 cup chopped onion
1 cup frozen mixed vegetables
1 can (14.5 oz) diced tomatoes, drained
1 jar (12 oz) beef gravy
1/4 teaspoon dried marjoram leaves
1/4 teaspoon pepper
1 1/3 cups water
2 tablespoons butter or margarine
1/2 teaspoon garlic salt
1/3 cup milk
1 cup mashed potatoes (dry)
1 tablespoon chopped fresh parsley
DIRECTIONS:
In 12-inch nonstick skillet, cook beef and onion over medium-high heat, stirring frequently, until beef is thoroughly cooked; drain.
Stir in mixed vegetables, tomatoes, gravy, marjoram and pepper. Heat to boiling. Reduce heat to low; simmer uncovered 8 to 10 minutes, stirring occasionally, until vegetables are tender.
In 2-quart saucepan, heat water, butter and garlic salt to boiling. Remove from heat. Stir in milk, dry potatoes and parsley just until moistened. Let stand about 30 seconds or until liquid is absorbed. Fluff potatoes with fork. Serve beef mixture over potatoes.
TIPS:
Oregano can be used in place of the marjoram; both are mint-family herbs from the Mediterranean mountains.
In place of the potatoes, try this thick, rich stew over biscuits, rice or pasta.
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